
Занятие 4. 

4.1 Пролекарства. Эмпирические основы их дизайна. 

Фармакокинетические свойства лидерных молекул (показатели АРМЭТ) 

 

Термин «пролекарство» введён в 1958 г. для обозначения 

биопредшественника истинного ЛВ или же ЛВ, имеющего защитные группы, 

легко удаляющиеся в организме пациента. Позднее возникла концепция 

пролекарств (по аналогии с концепцией защитных групп в органическом 

синтезе) как приём активации истинного ЛВ (ИЛВ). Дизайн 

пролекарственного вещества (проЛВ) заключается в превращении ИЛВ в 

биологически не активное вещество благодаря введению в ИЛВ легко 

биотрансформируемых группировок. Последние должны придавать проЛВ 

нужные физико-химические и фармакокинетические показатели-свойства 

(АРМЭТ): 

1) необходимый уровень абсорбции жировыми тканями (для 

преодоления защитных барьеров, например, липофильных клеточных 

мембран).  

2) хорошее распределение ЛВ в организме, транспорт и адресную 

доставку к биомишени.  

3) достаточную устойчивость к метаболизму ЛВ защитными 

ферментными системами организма (иначе ЛВ слишком быстро выводится в 

виде метаболитов из организма пациента), и в то же время нужную 

пролонгированность метаболического снятия введённых 

фармакокинетических групп атомов после достижения пролекарством 

мишени. Определённая замедленность превращения проЛВ в ИЛВ в районе 

биомишени необходима для длительного создания терапевтических 

концентраций ИЛВ, что приводит к уменьшению доз вводимого ЛВ и к 

снижению токсических эффектов.  

4) Хорошую выводимость из организма (экскрецию, 

элиминирование) без его аккумулирования после проявления лечебного 

эффекта.   

5) в целом незначительную токсичность (в случае выраженной 

токсичности ИЛВ оно на пути к целевой мишени может оказать 

отравляющее действие или другие нежелательные эффекты при контакте с 

другими органами-мишенями – раздражение ЖКТ, болезненные ощущения, 

горький вкус, тошноту, рвоту и т.п.).  

6) хорошую растворимость в воде (что особенно важно для 

перорального введения ЛВ). 

В дизайне пролекарств с целью улучшения показателей АРМЭТ 

широко пользуются методами, основанными на зависимости активности от 

строения (ЗАС или SAR). Так, для достижения в молекуле пролекарства 

нужного баланса между её гидрофильной и липофильной областями можно 

применить химическую модификацию исходной структуры истинного 

лекарства. При этом вводят такие группировки атомов, которые улучшают 

прохождение пролекарства через защитные барьеры организма (кожу, 



слизистые оболочки, ГЭБ, клеточные мембраны), повышают его абсорбцию 

и распределение в организме пациента.  

Ознакомимся с некоторыми примерами создания пролекарств 

изменением методами химических модификаций структуры истинного ЛВ 

его гидрофильно-липофильного баланса с целью лучшего прохождения ЛВ 

через защитные барьеры организма больного.  

В случае истинных ЛВ (1), содержащих спиртовые или 

карбоксильные группы (ЛВ 8), наиболее подходящим приёмом для 

изменения указанного баланса является химическое превращение этих групп 

действием соответствующими реагентами в легко гидролизуемые 

сложноэфирные группы (проЛВ 2-7, 9): 

 
Синтез эфиров (2 и 3) приводит к уменьшению водорастворимости 

при переходе от ИЛВ (1). Наличие катионных центров у эфиров (4 и 9) и 

отрицательных зарядов, возникающих при диссоциации кислотных групп у 

эфиров (5 и 7) повышает их водорастворимость. Конкретным интересным 

примером эффективности применения концепции синтеза проЛВ для 

придания сразу двум истинным ЛВ – гамма-аминомасляной кислоте (ГАМК) 

и её β- винилпроизводному (вигабатрину) высоких липофильных свойств, – 

служит синтез триглицерида (10; остатки этих двух ИЛВ выделены жирным 

шрифтом). Подобный тройной сложный эфир был предназначен для его 

хорошего прохождения через ГЭБ, который защищает нейронные клетки от 

случайного воздействия гидрофильных ксенобиотиков. Известно, что 

представители семейства лидера-ГАМК трудно проникают через 

липидоподобный барьер ГЭБ к ГАМКрецепторам из-за своего цвиттер-

ионного строения. Поэтому сильная липофилизация пролекарственной 

структуры, содержащей остатки сразу двух активных нейротропных молекул, 

которые присоединены в виде эфиров к монолинолоилглицериду (остаток 

линолевой кислоты выделен курсивом), привела к резкому улучшению 

проникновения данных нейротропных средств в мозговую ткань. В 

результате резко повысилась адресность их доставки к биомишени и 

антиконвульсивная активность. 



 
Следует ещё раз отметить, что ПроЛВ (с введёнными в исходные 

ИЛВ сложноэфирными группами) затем легко гидролизуются в организме 

пациента ферментами: эстеразами, сульфатазами и фосфатазами, с 

генерацией ИЛВ. Однако, этот метаболический эффект не всегда достигает 

приемлемого уровня. Так, в случае аспирина его кислотность, вызывающую 

раздражение и кровоточивость желудка и ЖКТ, понижают превращением 

карбоксильной группы в сложноэфирную группу. Тем не менее, химическая 

и метаболическая деэтерификация получаемых при этом производных всё 

ещё не достаточно велика.  

 Эмпирический дизайн проЛВ (12, 13) на основе ИЛВ, имеющих 

аминные функциональные группы (11), проводится обычно для снижения 

токсичности, основности ЛВ и увеличения их липофильности. Чаще всего 

при этом аминогруппы превращают в амидные, карбаматные и иминные, 

которые затем достаточно легко метаболизируются (гидролизуются) с 

высвобождением ИЛВ: 

 
Так, иминопроизводное ГАМК (проЛВ прогабид 14) – приобретает 

липофильность, достаточную для транспорта в мозг через ГЭБ, где в 

близости от биомишени (ГАМК-рецептора) биохимически гидролизуется с 

образованием свободной ГАМК, которая благодаря этому приёму оказывает 

более мощное антиконвульсантное действие. Структуру (2-HO,5-F)C6H3-

C(Ph)=N(CH2)3C(O)NH2 (14) получают конденсацией ГАМК (ИЛВ-NH2 11) с 

диарилкетоном (2-HO,5-F)C6H3C(Ph)=О (15).  

 ИЛВ, имеющие карбонильную (кетонную или альдегидную) группу, 

превращают в такие проЛВ, снабжённые оксимными, иминными, 

кетальными, ацетальными, оксазолидиновыми или другими легко 

гидролизуемыми группировками, конструируя таким образом лидерные 

структуры с нужными фармакокинетическими характеристиками. 

Простейший альдегид – метаналь – используют только наружно как 

антисептик в виде слабых водных растворов для дезинфекции рук, кожи и 

инструментов, т. к. он весьма токсичен для энтерального приёма. Чтобы 

избежать токсичности формальдегида в больших концентрациях и острого 

запаха у этого дезинфектантаантисептика мочеполовых путей, его 

используют при приёме внутрь через рот в виде проЛВ уротропина 

(метиленамина, гексаметилентетрамина, тетраазаадамантана). 

Антисептическое действие такого проЛВ основано, по-видимому, на его 

постепенном разложении до формальдегида и иона аммония, ускоряемом 

при кислых значениях pH. Этот проантисептик легко получают 



конденсацией водных растворов метаналя и аммиака через образование 

промежуточного гексагидро-1,3,5-триазина.  

 Остановимся ещё на одном примере экспериментального дизайна 

современного проЛВ – (S)-3,4-дигидроксифенилаланина (16, L-допа или 

леводопа). Его используют в лечении паркинсонизма – 

нейродегенеративного заболевания старческого возраста. Для этой болезни 

характерно дрожание мышц («дрожательный паралич»), потеря их 

эластичности, согбенная поза, маленькие шаги. Как правило, она 

заканчивается параличом из-за недостатка выделения мозгом 

нейромедиатора допамина. Леводопу принимают через рот в виде таблетки, 

которая растворяется в пищевом тракте. Поступая затем в кровь, это проЛВ 

постепенно проникает через ГЭБ в нейронные клетки, где ароматическая L-

аминокислотная декарбоксилаза метаболически отщепляет от неё диоксид 

углерода, превращая её в нейромедиатор 1амино-2-(3,4-

дигидроксифенил)этан (допамин, дофамин). Синтез леводопы (16) 

осуществляют конденсацией ароматического альдегида (17) с глицином (18): 

 
Основной стадией является асимметрическое гидрирование стирола 

(19) с помощью хирального катализатора на основе дифосфина родия 

HRh[CH2PPhC6H4OMe-4]2. При этом образуется L-изомер кислоты (21) с 

выходом 90% и энантиомерной селективностью до 95%. На заключительной 

стадии проводят снятие защитных ацильных групп гидролизом в 

присутствии HBr. 

 

4.2 Принцип антиметаболитов в умозрительном дизайне ЛП 
 

Концепция антиметаболитов базируется на создании синтетического 

ЛВ структурно близкого к какому-либо естественному (эндогенному) 

метаболиту организма человека. Задача такого ЛВ, называемого 

антиметаболитом (ксенометаболитом или псевдометаболитом), состоит в 

подмене природного метаболита в биохимических реакциях (прием 



«троянский конь»). Антиметаболиты должны быть способны лишь частично 

выполнять в организме функции метаболитов. Являясь химическими 

имитаторами истинных метаболитов, ЛВ такого рода "обманывают" 

контролирующие ферментные системы, встраиваются в метаболическую 

схему и заменяют собой настоящий метаболит, например, в растущей 

цепочке ДНК или РНК. Включение псевдометаболита в НК приводит к 

прекращению их роста, развития и репликации, что заканчивается гибелью 

микроорганизма. Важной характеристикой синтетических антиметаболитов, 

является то, что они обладают малой токсичностью и не оказывают 

нежелательных побочных эффектов, благодаря высокой степени их 

узнаваемости системами организма, для которых эти лекарственные 

вещества структурно «выглядят» эндогенными, почти не чужеродными.  

 На основе концепции антиметаболитов нуклеиновых оснований в 

последней четверти 20-го века была создана важная группа 

противовирусных препаратов – производных пурина, в частности, ИЛВ 

ацикловир (зовиракс 1) и его проЛВ валацикловир (2, производное Lвалина, 

которое в пять раз более биодоступно орально, чем ацикловир):  

 
Ацикловир (1) синтезировали в качестве имитатора-аналога 

нуклеозида – дезоксигуанозина (3), участвующего в биосинтезе нуклеиновых 

кислот. Идея заключалась в том, чтобы ксенобиотик – антиметаболит (1), 

попадая в зараженную вирусом клетку, имитировал собою эндогенный 

нуклеозид (3). Но поскольку в структуре лекарственного вещества 

отсутствует рибозильный фрагмент с 5’-ОН- группой, при введении 

имитатора в структуру растущей ДНК ее дальнейший рост должен 

прекратиться. Так оно и оказалось, причем выяснилось, что ацикловир имеет 

самое мощное антивирусное действие в отношении вируса герпеса. 

Герпесные инфекции – очень распространенное явление. Достаточно сказать, 

что только в США ими заражены десятки миллионов человек. При 



герпесном энцефалите от воспаления мозга гибнут три четверти пациентов, а 

в случае химиотерапии ацикловиром выживаемость возрастает в три раза. 

Поэтому появление ацикловира в клинике быстро привело к его широкому 

использованию во всем мире, а авторы этого ЛВ удостоились в 1988 г. 

Нобелевской премии.  

Принцип антиметаболитов сыграл важную роль в создании семейства 

ЛП в борьбе против СПИДа – открытой в США в начале 1980-х годов 

болезни, названной синдромом приобретенного иммунодифицита (СПИД; 

по-английски AIDS – acquired immunodeficiency syndrom). В 2006 году число 

инфицированных вирусом иммунодефицита человека (ВИЧ) во всем мире по 

разным данным достигло от 30 до 50 млн человек. Любой вирус (вирион) 

состоит из нуклеиновой кислоты (НК), защищаемой капсидой 

(цилиндрической или сферической оболочкой белкового типа, иногда с 

включением липидов и сахаров). Капсида выполняет также функцию 

взаимодействия с клетками чужого организма, способствуя проникновению 

вирусной НК внутрь клетки-хозяина и запуску там синтеза новых вирусных 

молекул. В случае ВИЧ сложность заключается в том, что в чужом 

организме он встраивается в клетки самой иммунной системы (в лейкоциты, 

фагоциты, лимфоциты), призванной бороться с патогенными 

микроорганизмами. И как только зараженный организм включает в действие 

защитную иммунную систему, то вместе с размножением собственных 

иммунных клеток начинается бурный рост числа ВИЧ и клетка-хозяин 

теряет генетический контроль над биопроцессами. Иммунные силы 

организма (его сопротивляемость) таким образом слабеют и у больных 

СПИДом возрастает возможность заражения другими инфекциями - 

туберкулезом, пневмонией, лейкозами и т.д. Точками воздействия 

(биомишенями) лекарственных веществ на ВИЧ могут быт: капсида (ее 

разрушение), нуклеиновая кислота – НК (ее мутация, ингибирование или 

разрыв) и, наконец, ферменты, которые участвуют в репликации НК. 

Некоторые синтетические лекарственные вещества (например, группа 

нуклеозидных ингибиторов обратной транскриптазы 4-8), используемые 

против СПИДа, имеют нуклеозидную или близкую к ней природу. Они 

считаются антиметаболитами, которые могут «спутать карты» вирусной НК, 

встраиваясь в неё. Подобная модификация останавливает дальнейший рост 

НК, т. к. в рибозильном цикле (или аналогичном ему гетероцикле) 

отсутствует группа ОН, которая необходима для фосфорилирования. 



 
Установлено, что эти препараты в организме фосфорилируются 

клеточными ферментами до 5’-трифосфатов и в этой форме являются 

конкурентными ингибиторами обратной транскриптазы ВИЧ (ОТ ВИЧ), 

которая катализирует транскрипцию одноцепочечной вирусной РНК в 

двухцепочечную ДНК. Являясь пролекарствами, нуклеозидные антиспидные 

препараты воздействуют на ферментную биомишень и оказываются 

терминаторами роста цепи вирусной ДНК, что приводит, таким образом, к 

остановке размножения ВИЧ. Замечено также, что указанные 5’-трифосфаты 

могут ингибировать ДНК-полимеразы клетки-хозяина и давать значительные 

токсические эффекты. При длительном использовании препаратов 

появляются резистентные к ним штаммы ВИЧ, в которых репликация на 

уровне НК уже не нарушается. Длительное использование AZT (4) вызывает 

мутации в активном центре ОТ ВИЧ в кодонах Asр. 67 (он переходит в кодон 

Asn), Lys 70 (мутирует в Arg) и Thr 215 (дает кодон Tyr). Таким образом, 

модифицированная ОТ ВИЧ уже не подвержена ингибированием 

азидовудином (4), который нашёл наиболее широкое применение. 

Интересно, что это вещество впервые было синтезировано еще в 1964 году в 

рамках поиска противораковых средств. До 1991 г. AZT оставался 

единственным препаратом против СПИДа на фармацевтическом рынке.  

 Существует несколько стратегий снижения уровня токсичности у 

известных препаратов, используемых против СПИДа. Одна из них 

базируется на резком улучшении плохой проходимости AZT и ему подобных 

нуклеозидных препаратов через липидные мембраны. С этой целью 

синтезируют их фосфатные производные (типа проЛВ фосфазида 5) и вводят 

подобные пролекарства в искусственные носители-липосомы. 



Приготовленная в таком виде система "препарат + матрица" хорошо 

преодолевает мембранный барьер лейкоцитов. Фосфатидилпроизводное (5) 

лучше проникает через фосфолипидные оболочки макрофагов (клетки 

иммунной системы) и накапливается там же, где обычно концентрируются и 

вирусы иммунодефицита человека (ВИЧ). Это пролекарство, гидролизуясь в 

макрофаге до довольно токсичного для организма человека истинного ЛВ 

азидотимидина, действует, таким образом, адресно – как «магическая пуля», 

– только на зараженные иммунные клетки и оказывает в несколько раз 

меньшую токсичность. 

 

4.3 Конформационный анализ в программе HyperChem 

 

Результат оптимизации зависит от стартовой геометрии молекулы и 

гарантированно приводит к ближайшему локальному минимуму на ППЭМ, 

однако, если молекула имеет большое количество конформаций, процесс 

поиска глобального минимума на ППЭМ значительно усложняется. 

В случае простых молекул возможен прямой перебор всех 

конформаций. Пример: постройте две модели молекулы бутана – анти- и 

гош- конформеры; установите силовое поле mm+; введите одну из 

конформаций (например анти-) и проведите оптимизацию геометрии; 

произведите расчет энергии молекулы в одной точке (Compute->Single Point) 

и запишите ее значение; затем, перейдите в режим выделения, нажав на 

кнопку панели управления . Выделите четыре связи, которыми образован 

двугранный угол (C-C-C-C) и измените его значение на 0 (Edit->Set Bond 

Torsion) – при этом получится стартовая геометрия для гош-конформации, 

затем (это важно!), снимите выделение, нажав правую кнопку мыши на 

темном фоне графического окна. Проведите оптимизацию геометрии. В 

случае использования силового поля mm+ энергии составляют: 3.04 для гош-

конформации; 2.17 для анти-конформации. Следовательно, можно сделать 

вывод, что анти-конформер стабильнее чем гош-конформер. 

Для решения сложных конформационных задач существует 

наглядный способ визуализации зависимости потенциальной энергии от 

величины двугранного угла – построение потенциальной кривой. Выделите 

двугранный угол C-C-C-C и запустите построение потенциальной кривой 

(Compute->Potential…), при этом возникнет меню выбора параметров 

построения потенциальной кривой (Рисунок 1). 

 
Рисунок 1 Параметры построения потенциальной кривой. 



Установите параметры Initial Bond Angle (начальное значение угла) и 

Final Bond Angle (конечное значение угла) 0 и 360 градусов соответственно, а 

Step (шаг) 10 градусов. Запустите процедуру. При этом по окончании 

вращения будет построена потенциальная кривая (), на которой виден 

минимум потенциальной энергии для вращения вокруг данного двугранного 

угла. Сравните полученный угол минимальной энергии с ранее полученным 

результатом. 

 
Рисунок 2. Потенциальная кривая. 

В ряде случаев использование потенциальной кривой для оценки 

оптимального угла не рекомендуется. Например, когда при повороте 

возникают значительные стерические напряжения или возникает 

перекрывание фрагментов химической структуры. В этом случае следует 

использовать автоматический конформационный анализ. Для этого в 

HyperChem предусмотрены специальные процедуры. 

Рассмотрим конформационный анализ на примере L-глутаминовой 

кислоты (Рисунок 3). 

 
Рисунок 3. Трехмерная структура L-глутаминовой кислоты (а1, а2, а3 – 

торсионные углы для конформационного поиска). 



Прежде всего, необходимо указать, какие валентные углы будут 

варьироваться в процессе конформационного анализа. Данный этап 

реализован в HyperChem не очень удобно. Прежде чем приступать к анализу, 

необходимо выделить и присвоить каждому из углов имя. Выделите три 

связи, соответствующие валентному углу a1 (для вращения вокруг связи С-

С), путем выделения двух прилежащих связей и связи указанной на рисунке 

стрелкой a1. Затем выберите пункт меню Select->Name Selection… Укажите 

имя угла a1. Аналогично присвойте имена двум оставшимся углам (сначала 

выделяя, а затем присваивая имя). Теперь запустите конформационный 

анализ Compute- >Conformational Search… : 

 
Рисунок 4. Окно конформационного анализа. 

В меню конформационного анализа выберите Options->Choose 

torsions. В левой колонке (Named Torsion Angles) должен быть список 

выбранных углов (a1,a2,a3). Выделите их все и нажмите кнопку Add. Углы 

будут добавлены в колонку Torsions to Vary (углы, которые будут 

варьироваться): 

 
Рисунок 5. Выбор торсионных углов. 

Варьирование углов используется для получения различных 

стартовых точек для оптимизации. Углы могут варьироваться с некоторым 

шагом и в определенном диапазоне, который задается в Options->Setup 

Ranges…: 



 
Рисунок 6.Задание параметров варьирования углов. 

Для выбора метода конформационного поиска выберите пункт меню 

Options->Search Method…: 

 
Рисунок 7. Параметры конформационного поиска. 

В рамке Initial Conformations – выбор начальных конформаций: 

Usage Direction – по мере использования; Random Walk – случайный 

выбор (повышает вероятность полного охвата всего конформационного 

пространства). 

В рамке Acceptance Energy Criterion – критерий выбора конформации 

в соответствии с ее энергией: Maximum – максимальное отклонение энергии 

от энергии конформации с низшей энергией, в случае превышения 

конформация не используется; Metropolis criterion – вероятностный выбор 

конформации в соответствии с распределением Больцмана (задается 

температура). 

Перед запуском поиска в меню File активизируйте опцию Autosave. 

При этом вся информация в процессе поиска будет записываться в файл. 

Запустите процесс конформационного поиска Run->Start. Создайте файл 

конформационного анализа, в котором будет сохраняться вся информация о 

ходе анализа, в том числе и структуры различных конформеров, которые 

можно в дальнейшем вызывать. 

В процессе анализа таблица со свойствами конформаций будет 

расширяться по мере нахождения новых конформеров. При этом ее строки 

сортируются по энергии. Таблица имеет следующие колонки: Energy – 

энергия конформера; Gradient – градиент в конце оптимизации; Found – 



сколько раз данная конформация была найдена; Used – сколько раз данная 

конформация была использована для генерации новых конформаций. 

Далее следуют колонки со значениями валентных углов, подлежащих 

варьированию. 

 
Рисунок 8. Результаты конформационного поиска. 

Основные параметры, приведенные в поле Search Progress: 

Conformations – количество конформаций; Lowest found – конформация с 

наименьшей энергией; Highest kept – конформация с наибольшей энергией. 

Остановить процедуру поиска можно путем нажатия Cancel. Однако 

можно задать количество конформаций в меню Options->Limits. После 

остановки анализа его можно возобновить Run->Resume. После завершения 

можно просмотреть структуры полученных конформаций. Для этого нужно 

выделить соответствующую строку таблицы выбрать пункт меню Edit->Put 

Molecule, либо нажать сочетание клавиш Ctrl+U. 

 

4.4 Особенности конформационного поиска 

 

Для малых молекул конформационный поиск возможно проводить и 

вручную, т. к. количество их не велико, а наиболее стабильная конформация 

обычно очевидна. Тем не менее, для проведения такого поиска требуются 

определенные навыки, и, порой, выбор становиться интуитивным. 

Безусловно, здесь присутствует элемент субъективности, но такой подход 

позволяет значительно ускорить обработку больших массивов молекул. 

Можно предложить ряд рекомендаций, которые могут оказаться полезными. 

1. Обычно конформации с наименьшей энергией занимают 

наибольший объем, т.е. выглядят «развернутыми». Важно исключить 



сильное пространственное сближение заместителей (пример – фолиевая 

кислота): 

 
Рисунок 9. Конформации молекулы фолиевой кислоты. 

2. Двугранные углы в углеродном скелете линейных органических 

молекул в большинстве случаев составляют около 180
o
: 

 
Рисунок 10. Фрагмент молекулы углеводорода. 

3. Обычно пептидная связь имеет транс-конфигурацию: 

 
Рисунок 11. Пептидная связь. 



4. В циклических молекулах обычно меньше энергия конформаций с 

экваториальным расположением заместителей. Однако, при этом важно 

соблюдать стереоизомерию молекулы. Чтобы изменить положение 

заместителя с аксиального на экваториальное, просто удалите атом водорода 

у его основания, поместите его на противоположную сторону и вновь 

запустите оптимизацию геометрии: 

 
Рисунок 12. Изменение положения заместителя. 

5. Для циклических молекул конформация «кресла» обычно 

стабильнее. Для быстрого перевода циклогексана из конформации «ванна» в 

конформацию «кресло» можно воспользоваться следующим приемом: 

а. Добавьте в молекулу атом тяжелого элемента (у него 

достаточно большая длина связи), как показано на рисунке ниже; 

б. Проведите оптимизацию геометрии (полного 

завершения дожидаться необязательно); 

в. Сотрите атом тяжелого элемента и добавьте атомы 

водорода Build- >Add Hydrogens. Запустите оптимизацию 

геометрии. 

 
Рисунок 13. Изменение конформации. 

 

4.5 Определение активной группы в семействах биологически активных 

веществ. Принцип фармакофора. Умозрительный и эмпирический дизайн 

опиоидных анальгетиков на основе лидера-морфина 



 

Многие годы ведутся работы по модификации-упрощению структуры 

лидерной молекулы морфина с целью установления фармакофорного 

фрагмента и получения на его основе новых синтетических кандидатов и ЛВ 

обезболивающего действия и при этом не оказывающих наркотического 

эффекта. Так, было установлено, что кислород, формирующий фурановый 

фрагмент в морфине, не столь существен для проявления им и его аналогов 

обезболивающей активности. Например, его дезоксианалоги (морфинаны) 

оксилорфан (1) и буторфанол (2) обладают сильно выраженными 

смешанными свойствами агонистов-антагонистов морфина, возможно, 

благодаря лучшей конформационной подстройки циклогексанового кольца к 

рецептору:  

 
Дальнейшее постепенное упрощение пентациклического строения 

морфина (удаление групп атомов, малоактивных к связыванию с 

биорецептором) позволило сохранить определенную топографию 

потенциального анальгетика в указанном ниже ряду: 

 
В результате удаления циклогексанового кольца были синтезированы 

вещества группы бензоморфанов (пентазоцин и др.), которые обладают 



меньшими анальгетическими и наркотическими эффектами по сравнению с 

морфином. Затем в результате следующего этапа умозрительного и 

экспериментального дизайна – «вырезания» бензильной СН2-группы 

(расщепление второго циклогексенового фрагмента), был осуществлён 

переход к большому семейству мощных анальгетиков 4-арилпиперидинового 

ряда, обладающих выраженным наркотическим действием. Обнаружение 

анальгетической активности у серии производных 4-фенилпиперидина 

привело к выводу правила Бекетта-Кейзи, оказавшегося, несмотря на свою 

упрощенность, полезным на определенном этапе создания 

фармакологического блока морфиноподобных анальгетиков, особенно в 

1960-1970-х годах. В соответствии с этим правилом при "конструировании" 

потенциального фармакофора – биоизостеричного морфину анальгетика, 

взаимодействующего с морфиновым рецептором µ-опиоидного типа, 

необходимо, чтобы его структура включала: 1) четвертичный атом углерода; 

2) ароматическое кольцо при этом атоме; 3) третичный атом азота на 

расстоянии, эквивалентном двум атомам углерода sp
3
конфигурации, считая 

от указанного четвертичного атома углерода: 

 
Расширение шестичленного пиперидинового кольца до семичленного 

(этогептазин 3) или сужение гетероцикла до пирролидинового (пролидин 6) 

не снижает анальгетическую эффективность. Это правило фармакофора 

работает не только в случае алкоксикарбонильного заместителя при С-4 

гетероцикла, но и при его замене на такие группы, как гидроксильная, 

ацилоксильная, амидная и алкильная (хотя есть и значительное число 

примеров несоответствия данному правилу). Так, продин (4), просидол (5), 

пролидин (6) и промедол (тримеперидин, 7) являются эффективными 

анальгетиками: 

 
Были сконстуированы новые анальгетики опиоидного типа, не 

содержащие циклического атома азота, которые можно отнести к группе 1-

арил-2-амино(аминометил)циклогексанов. Таковым является трамадол 

(структура приведена выше), обладающий свойствами агониста-антагониста 



опиатных рецепторов. Он дает быстрый и длительный эффект 

обезболивания, лишь немного уступающий по уровню активности морфину. 

Наконец, расщепление азациклоалканового кольца с переходом от 

анальгетиков типа (3-7) к полизамещённым диметиламиноизоалканам дало 

возможность сконструировать ещё две лидерные структуры (8 и 9), которые 

обладают обезболивающим действием: 

 
Метадон (8) имеет такую же активность как морфин. Его (-)изомер 

нашёл применение в лечении синдрома героиновой абстиненции. Дарвон 

(декстропропоксифен – правовращающий диастереомер, 9) проявляет в два 

раза меньшую анальгетическую активность кодеина. 

 

4.6 Химические особенности гликозидов. 

 

 ликози ды — органические соединения, молекулы которых состоят 

из двух частей: углеводного (пиранозидного или фуранозидного) остатка и 

неуглеводного фрагмента (т. н. агликона). В качестве гликозидов в более 

общем смысле могут рассматриваться и углеводы, состоящие из двух или 

более моносахаридных остатков. Преимущественно кристаллические, реже 

аморфные вещества, хорошо растворимые в воде и спирте. 

Гликозиды представляют собой обширную группу органических 

веществ, встречающихся в растительном (реже в животном) мире и/или 

получаемых синтетическим путём. При кислотном, щелочном, 

ферментативном гидролизе они расщепляются на два или несколько 

компонентов — агликон и углевод (или несколько углеводов). Многие из 

гликозидов токсичны или обладают сильным физиологическим действием, 

например, гликозиды наперстянки, строфанта и другие. 

В молекулах гликозидов остатки сахаров связаны с агликоном через 

атом О, N или S.  

В зависимости от природы этих связывающих атомов различают: 

 О- гликозиды – О– НН-О– С6Н11О5 

 С- гликозиды – C– НН-О– С6Н11О5 

 N- гликозиды – N– НН-О– С6Н11О5 

 S- гликозиды – S– НН-О– С6Н11О5 

Наибольшее распространение в природе имеют   О-гликозиды. 

В зависимости от химической природы агликона лекарственные О-

гликозиды делятся на группы: 

 Цианогенные гликозиды (синильная кислота) 

 Сердечные гликозиды 

 Сапонины (тритерпеновые и стероидные соединения) 



 Антрагликозиды (антрацен) 

 Гликозиды-горечи 

Сердечные гликозиды - это биологически активные вещества, 

содержащиеся в некоторых видах растений и обладающие способностью в 

весьма малых дозах оказывать специфическое действие на сердечную 

мышцу. 

По химической структуре сердечные гликозиды  (как и другие) 

представляют собой эфиры, в молекулах которых гликозидной связью 

связаны между собой  агликон и остатки моно-, ди-, три- или тетрасахарида. 

 
Сердечные гликозиды как правило нейтральные соединения. 

Они чувствительны к действию кислот и щелочей. Под действием 

кислот происходит отщепление легко гидролизуемых 2-дезоксисахаров  

Под действием щелочи происходит необратимая изомеризация 

карденолидов или расщепление лактонного цикла с образованием 

фармакологически неактивных соединений. Под влиянием щелочи в 

лактонном цикле может происходить перемещение двойной связи из α-ß в ß-γ  

положение.  

Взаимосвязь между химической структурой и фармакологическим 

действием на организм: 

1.Агликон является носителем биологической активности; 

2. Сахарный компонент влияет на скорость всасывания и 

продолжительность действия; 

3. Специфическое действие гликозида на сердце (замедление частоты 

и усиление сердечных сокращений) обусловлено наличием в молекуле 

агликона пяти- или шестичленного лактонного цикла в положении 17; 

4. На кардиотоническое действие оказывают заместители в 

положении 10. 

Современные исследования в области сердечных гликозидов  

1. Поиск новых природных гликозидов и источников их получения; 

2. Химические и биохимические трансформации природных 

карденолидов и буфадиенолидов с целью улучшения их 

фармакотерапевтических свойств; 



3. Повышение содержания сердечных гликозидов в культивируемых 

видах растений с помощью агротехнических приемов и выведения новых 

видов. 

4. Разработка новых, более совершенных способов выделения из 

сырья гликозидов, применяемых в медицинской практике. 

 

4.7 Лабораторный практикум по квантово-химическому расчету физико-

химических свойств молекул в программе «HyperСhem» 

 

Полуэмпирический квантово-химический расчет молекул. 

Цель работы: Проведение молекулярно-механического (методом 

ММ+) и полуэмпирического квантово-химического расчета методом MNDO 

основного состояния молекул и химической интерпретации полученных 

результатов. 

Порядок работы 

1. Запустить программу HyperChem.  

Осуществляется щелчком по иконке программы на рабочем столе 

Windows или по файлу Chem.exe в рабочей папке программы 

(С:\Hyper8\Program\).  

2. Построить предложенную многоатомную молекулу.  

Для этого разместите на рабочем поле программы атомы 

предложенной преподавателем гетероциклической молекулы, соблюдая 

следующие правила: сначала выставляются атомы углерода (ароматические 

кольца, алифатические цепи), затем остальные группы атомов по очереди 

(все кроме атомов водорода!), придерживаясь направления вывода атомов по 

часовой стрелки. Нумерация атомов пройдет автоматически. Для облегчения 

строения сначала повторите схему молекулы на бумаге. 

3. Добавление атомов водорода и оптимизация начальной геометрии 

молекулы с помощью построителя модели.  

Построенную модель автоматически достраивают добавлением 

атомов водорода в соответствии с представлениями о стандартной 

валентности элементов и установленной кратностью связей между атомами. 

Для устранения неточностей выполненного рисунка и построения схемы с 

более правильной геометрией и коррекцией межатомных расстояний и 

валентных углов в меню Build выберите Add H & Model build. При этом 

двухмерная схема может преобразоваться в трехмерную. Если атомы 

водорода не отображаются, то в меню Display необходимо отметить опцию 

Show hydrogens. 

 Сохраните результаты в hin-файле программы HyperChem в вашу 

рабочую папку под отдельным именем (например, Нитробензол.hin). 

4. Запуск log-файла протокола расчета.  

В меню File выбирают Start Log. Файлу дают название и 

устанавливают степень полноты записи протоколов 

молекулярномеханического расчета Mechanics print level = 9. 

5. Расчет молекулы.  



Первый метод: Оптимизация геометрии молекулы методом 

молекулярной механики. В меню Setup выбирают метод молекулярной 

механики (ММ+) (Molecular Mechanics); в раскрывшемся окошечке 

устанавливают MM+.  

Запускают процесс оптимизации геометрии в меню Compute > 

Geometry Optimization. После окончания процесса оптимизации в нижней 

строке окна появляется надпись Converged=YES и исчезнет блокировка 

верхнего меню.  

После каждого расчета одним из выбранных методов перед новым 

расчетом выполняют физико-химическую интерпретацию полученных 

результатов. 

6. Интерпретация результатов расчета методом молекулярной 

механики  

6.1. Анализ строения молекулы. Расчет молекулярных координат 

(длин связей, произвольных расстояния между любыми атомами, валентных 

и торсионных углов). 

Прежде чем запустить процесс оптимизации геометрии молекулы 

полуэмпирическим квантово-химическим методом MNDO, целесообразно 

определить геометрические характеристики (длины связей и валентные углы) 

молекулы, полученные в ходе оптимизации методом молекулярной механики 

ММ+.  

Измерения геометрии молекулы в HyperChem описано в п. 4 первой 

главы. Выберите для вашего соединения 5 разных характеристических 

межатомных расстояния и 3 валентных угла (рекомендуется выбирать 

параметры симметрично независимой части молекулы). Занесите все 

значения длины связи (в Å) и валентного угла (град) из строки состояния в 

общую таблицу для сравнения. 

Сравните геометрию молекулы, полученную с помощью методов 

ММ+, MNDO с экспериментом (используйте химические 

справочники в Интернет). Сделать вывод о точности проведенного расчета.  

Как видно точность метода MNDO составляет ≈0.04 Å для длин 

связей и ≈3-4° для валентных углов. 

Полученную картинку с видом молекулы необходимо скопировать, 

используя меню Edit > Copy image (F9). При этом изображение помещается 

в буфер обмена, откуда может быть вставлено в любой текстовый или 

графический редактор. Полученное изображение сохраните под 

соответствующим именем в своей рабочей папке. 

Включить отображение номеров или символов атомов можно, выбрав 

в меню Display > Labels, и далее параметр Number или Symbol. Для 3-х 

мерных форм отображения молекулы выберите в меню Display > Rendering. 

7. Закрытие log-файла. 

Выберите в меню File > Stop Log. 

Для метода MM+ интерпретация заканчивается и можно переходить к 

методу MNDO в следующем пункте. Сохраните результаты в hin-файле 



программы HyperChem в вашу рабочую папку под отдельным именем 

(например, Нитробензол_MM+.hin). 

8. Запуск log-файла протокола расчета. 

В меню File и выбирают Start Log. Файлу дают название и 

устанавливают степень полноты записи протоколов квантовохимического 

расчета Quantum print level = 9 

 
Рисунок 14. Вид молекулы на примере нитробензола 

9. Расчет молекулы. 

Второй метод: Оптимизация геометрии молекулы и расчет 

электронной структуры полуэмпирическим методом MNDO.  

В меню Setup выбирают Semi-empirical; в окне устанавливают 

MNDO (для молекул с элементами из III периода и старше - MNDO/d). При 

необходимости при помощи кнопки Options устанавливают 

соответствующий заряд, мультиплетность, основное (Lowest) или первое 

возбужденное (Next Lowest) состояние. Запускают процесс расчета с 

оптимизацией геометрии в меню Compute > Geometry Optimization. Расчет 

заканчивается, когда в низу окна появляется надпись Conv=YES и исчезнет 

блокировка верхнего меню. 

10. Интерпретация результатов полуэмпирического расчета  

10.1. Анализ строения молекулы. Расчет молекулярных координат 

(длин связей, произвольных расстояния между любыми атомами, валентных 

и торсионных углов). Продолжите заполнять таблицу с геометрическими 

параметрами молекулы. Дальнейшая интерпретация (пункты 10.2-10.10) 

выполняются только для MNDO, так как это касается электронной 

структуры. 

10.2. Расчет дипольного момента и отображение направления его 

вектора  

Включить отображение вектора дипольного момента можно, выбрав в 

меню Display > Show dipole moment. Если данная команда будет недоступна 

(серый цвет), то потребуется повторный запуск расчета молекулы (меню 



Compute > Single Point). Значения модуля дипольного момента приводятся в 

log-файле. 

 
Рисунок 15. Пример демонстрации дипольного момента НБ 

Для лучшего просмотра направления дипольного момента поверните 

молекулу при помощи инструментов вращения или увеличьте масштаб 

просмотра.  

Для выполнения последующих заданий копируйте, используя Edit > 

Copy image (F9), графическое изображение свойств или параметров 

молекулы для сохранения под соответствующим именем в своей рабочей 

папке.  

10.3. Оценка растворимости Оценка растворимости производится 

сравнением электрического дипольного момента молекулы с дипольными 

моментами известных растворителей, например: μ(Н2О) = 1,83 D, μ(CН3ОH) 

= 1,69 D (полярные растворители). 

На основании близости дипольных моментов делается вывод о 

преимущественной растворимости в полярном или в неполярном 

растворителе.  

Пример оценки растворимости НБ  

Величина дипольного момента нитробензола 5,25 D, т.ч. данное 

вещество растворяется в сильных полярных растворителях или само является 

растворителем, т.к. обладает большим дипольным моментом.  

Другой пример. Электрический дипольный момент молекулы CClF3 

имеет небольшую величину 0,27 D, следовательно, молекула CClF3 

растворима преимущественно в слабо полярных растворителях.  

10.4. Расчет эффективных зарядов атомов, карт электростатического 

потенциала и полной зарядовой плотности Включить отображение 



эффективных зарядов атомов можно, выбрав в меню Display > Labels, и 

далее параметр Charge. 

 
Рисунок 16. Пример оформления эффективных зарядов на атомах НБ 

Наблюдаемое распределение зарядов на атомах демонстрирует 

влияние замещение в бензоле водорода акцепторным заместителем. 

Построение распределения электростатического потенциала  

В меню Compute выберите Plot Molecular graphs. В окне выбирают 

Electrostatic potential и устанавливают 3D или 2D способ отображения. 

Данный рисунок показывает области положительного и отрицательного 

распределения электростатического потенциала. Положительный знак 

электростатического потенциала отображается зеленым цветом. В области 

неподеленных электронных парна атомах кислорода электростатический 

потенциал отрицательный, что отображается сиреневым цветом. 

 
Рисунок 17. Пример оформления электростатического потенциала (2 и 3 

D) и полной плотности заряда (2 D) НБ 

Это позволяет, например, сделать предположение о взаимодействии 

молекулы с растворителем. Очевидно, что катионы стремятся подойти к 

области отрицательного потенциала, анионы кположительной области. 



Например, при сравнении анилина (NH2)(C6H5) и нитроанилина 

(NH2)(C6H5)(NO2), в первом случае, на азоте видна неподеленная пара 

электронов, в то время как в случае нитроанилина она в большей степени 

втянута внутрь кольца.  

Далее в меню Compute выберите еще раз Plot Molecular graphs. В 

диалоговом окне установите Total charge density и 3D или 2D способ 

отображения.  

Для «выключения» распределения молекулярных потенциалов после 

того как Вы их скопировали, просто щелкните инструментом Выбор правой 

кнопкой мыши на свободном месте.  

10.5. Построение диаграммы энергетических уровней, графическое 

изображение молекулярных орбиталей верхней занятой (ВЗМО) и нижней 

вакантной (НВМО)  

Для получения энергетической диаграммы выберите в меню Compute 

> Orbitals.  

В отличие от неэмпирических расчетов (ab-initio), где учитываются 

все электроны системы, полуэмпирические методы (например, MNDO) 

используют валентное приближение. Например, для описания атома F 

учитывают только 7 электронов из 9. Для атомов N, O и C нитробензола 

также пренебрегают в MNDO всеми остовными 1s электронами. 

Заполненные орбитали выделяются не только цветом (заполненные 

зеленые, а вакантные сиреневые), но и при помощи галочки Labels.  

Для получения графического изображения МО в окне Orbitals 

выбирают номер нужной МО (Number), при этом уровень энергии 

приобретает красный цвет. Далее устанавливают 3D или 2D опции 

отображения, нажимают Plot и Ok. 

 
Рисунок 18. Характеристики и 2D формы граничных МО нитробензола 

Вклады АО в ВЗМО и НВМО (фрагмент секции Eigenvalues (eV) and 

Eigenvectors для нитробензола) 



 
Представлены только не нулевые значения, действительный размер 

таблицы будет гораздо больше. Положительные значения коэффициентов 

приатомных орбиталях дают связывающие вклады в МО, отрицательные 

значения - разрыхляющие вклады. 

10.7.Определение нуклеофильных и электрофильных 

(донорноакцепторных) свойств молекулы  

Данный выбор осуществляется по знаку энергии НВМО (нижней 

вакантной МО) молекулы: если знак «+» – молекула нуклеофил; знак «-» - 

электрофил. Объясним почему.  

Пример определение нуклеофильных и электрофильных свойств 

молекулы нитробензола Энергия НВМО (№24) = -1,221 эВ. Энергия НВМО 

отрицательна, следовательно, нитробензол – электрофил.  

В химических реакциях нуклеофил охотнее отдает электрон, а 

электрофил, наоборот, охотнее захватывает его. Если энергия электрона на 

НВМО положительна, это означает, что пребывание электрона на ней 

энергетически невыгодно, т.е., попав на нее при возбуждении, электрон 

может покинуть молекулу. Таким образом, при EНВМО > 0 молекула является 

акцептором электронов. Наоборот, если EНВМО < 0, «чужой» электрон, попав 

на наинизшую незанятую орбиталь молекулы, остается на ней, поскольку это 

энергетически выгодно, т.е. молекула будет донором электронов. 

10.8. Определение жесткости и мягкости молекулы.  

Определить потенциал возбуждения молекулы по формуле: ΔE= 

EНВМО - EВЗМО.  

Жесткость молекулы рассчитывается по формуле: η = (ЕНВМО – 

ЕВЗМО)/2.  

Мягкость молекулы связана с жесткостью соотношением: S=1/(2η), 

т.е. S=1/(ЕНВМО – ЕВЗМО).  



Реагент считается жестким, если энергетическая щель между ВЗМО и 

НВМО превышает 1 эВ; реагент считается мягким, если энергетическая щель 

между ВЗМО и НВМО менее 1 эВ.  

Пример определение жесткости или мягкости молекулы НБ У 

молекулы нитробензола разница между положениями НВМО и ВЗМО > 1 эВ. 

Вывод: Молекула НБ является жестким электрофилом.  

Жесткость молекулы: η = (ЕНВМО–ЕВЗМО)/2 = (-1,221 + 10,312)/2 = 4,545 

эВ.  

10.9. Расчет положения реакционных центров молекулы 

Положение главных реакционных центров в жестких реагентах 

приближенно определяется зарядами на атомах. Нужно привести 

распределение зарядов на атомах исследуемой молекулы по Малликену и на 

основании их величин и знаков сделать вывод о наиболее вероятных 

направлениях атак в химических реакциях.  

Положение реакционных центров в мягких реагентах определяется 

граничной плотностью электронов на атомах. Граничная плотность 

электронов на атоме А рассчитывается по формуле: 

        
 

   

 

где ciμ - коэффициенты разложения граничной МО (ВЗМО 

нуклеофила или НВМО электрофила) по АО, центрированным на атоме А. 

Можно рассчитать величины fА и на их основании сделать вывод о наиболее 

вероятных направлениях атак. 

Пример определение положения реакционных центров.  

Реакционная способность молекулы нитробензола как жесткого 

реагента определяется зарядами на атомах. Распределение максимальных 

зарядов на атомах следующее: 

O3 -0,342 

O2 -0,342 

N1 0,487 

Максимальный отрицательный заряд на атомах О. 

Вывод: Атомы О – наиболее вероятные центры электрофильной 

атаки. 

Для оценки направления атаки реагента на один из альтернативных 

реакционных центров также используют величины зарядов на них 

(зарядовый контроль), величины и знаки коэффициентов АО ВЗМО или 

НВМО (орбитальный контроль).  

Для сравнения реакционной способности в ряду соединений важно 

знать и величины и знак энергии граничных орбиталей ЕВЗМО и ЕНВМО. В 

реакциях электрофильного и нуклеофильного замещения в ряду 

ароматических и гетероароматических соединений используется зарядовый 

контроль. 



10.10. Моделирование вибрационного (колебательного) спектра 

молекулы и определение характеристик наиболее интенсивных мод 

колебаний. 

Колебания атомов исследуемых молекул рассчитываются с 

использованием координат атомов, полученных после оптимизации 

пространственных структур методами ММ+, MNDO. Расчет колебательного 

спектра запускается путем выбора пункта меню Compute > Vibration, 

Rotation Analysis. Расчет заканчивается, когда в нижней строке окна 

появляется надпись Calculating Vibrational Spectrum… или 100% и 

становится доступным верхнее меню. Время расчета вибрационного спектра, 

как и в случае определения электронной структуры и равновесной геометрии, 

пропорционально сложности молекулы.  

Просмотр результатов моделирования вибрационного спектра 

осуществляется в меню Compute > Vibrational Spectrum. Далее в окне 

Vibrational Spectrum выберите 3-4 самые интенсивные моды нормальных 

колебаний и зафиксируйте в отчете: номера, частоты и интенсивности 

активных полос. Значения частот (в см
-1

) также приводятся в финальной 

части log-файла (см. пример). 

 
Для просмотра колебаний выставите флажок Animate Vibrations и 

нажмите кнопку Apply. Остановить колебания можно командой Cancel в 

меню. Сравните модельный ИК-спектр с экспериментом. Все ли частоты 

положительны? Проанализируйте мнимое колебание с отрицательными 

частотами. 

10.11. Дополнительно приведите из log-файла энергетические 

характеристики молекулы (перевод в приложении 1). 

 



11. Закрытие log-файла.  

Выберите в меню File > Stop Log. Сохраните результаты в hin-файле 

программы HyperChem в вашу рабочую папку под отдельным именем 

(например, Нитробензол_MNDO.hin).  

12. Подготовьте отчет в редакторе Word или OpenOffice.  

Задание на лабораторную работу  

Согласно приведенного выше примера рассчитайте методами ММ+ и 

MNDO геометрическую структуру, электронные, спектральные 

характеристики и опишите химические свойства и реакционную способность 

одной из предложенных молекул.  

Отчет по работе должен состоять из 3-х частей, содержащих 

следующий материал:  

1. Предварительный расчет соединения молекулярномеханическим 

методом ММ+.  

2. Оптимизация полуэмпирическим методом MNDO.  

3. Интерпретация результатов расчета. Включите данные по 

молекулярной геометрии, вставьте все изображения и подпишите их, 

проведите обсуждение результатов. 
 


